Publisher_2013: Part 1
Akron-Summit County Basics Features

Public Library &jl

130-643-9145 Electronic Servioes Division
&0 South High Street, Akron, OH 44326

Publisher

Publisher is a desktop publishing program that helps you create professional-looking
publications and marketing materials. Whether you start with a blank page or choose one of
hundreds of pre-designed layouts (templates), Publisher can help you create great-looking
publications in the same amount of time (or less) than you'd spend using a word-processing
program such as Word.

Project 1:
J Bars s

1. Open Publisher. You're able to choose a category from the
top of the page.
2. For this exercise, click on the BUILT-IN heading.
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Informanon
Search for online templates pel Meehan, Dawn .
dmeehan@akronlibrary.org

|

Suggested searches:  Personal Design Sets Labels Event Paper Business Cards Switch account
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Customize

Blank 8.5 x 11" Blank 11 x 8.5" More Blank Page Sizes CI:IlI:Ir SChEmE'

|I5Ian|:| [ |

Font scheme

. (default termplate fonts)
3. Click on Flyers.

4. Click on Bars.

Business information:

5. You can pick a different color or font scheme by clicking on

| Create new... v|

the drop down.
6. You can choose whether you want to Include graphic. For Options

class leave the box checked. [JInclude mailing address
7. You can choose whether you want to include Tear-offs. For [] Include graphic

class choose Contact information. Tear-offs:
8. Click the CREATE button.
9. Your flyer will open in editing mode. EI MNone v
10. Click in the business name area and type: Akron-Summit

County Public Library.
11. Click in the Product/Service Information and type: Laser

Engraver/Cutter Training. CREATE
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12. Click on the Business Tagline or Motto text box and press the delete key on your
keyboard.
13. Click in the Primary Business Address area, highlight the four lines of text and type:
a. TechZone@Main
b. 60 S High St
C. Akron OH 44326
Note: Press enter after each line.
14. Click in the Phone, Fax, Email area, highlight the three lines of text and type:
a. Phone: 330-643-9145
b. Email: esdiv@akronlibrary.org
15. Click on the Organization box and press the delete key on your keyboard.
16. Click in text box that starts Place text and type:

a. Come to the TechZone@Main every Wednesday night from 5:30-7:30 to learn
the ins and outs of the Laser Engraver/Cutter. We will begin week one with
some basic skills and progress until the four week with a finished product. If
you have any questions or to register for the class, please call the
TechZone@Main.

b. Highlight the text and change text to Arial 16.

17. Click on the area above the text box to insert a picture.

18. Click on the thumbnail of a photo in the center of the box.
19. Click on Browse to find a picture saved on the computer.
20. Click on Pictures folder.

21. Click on the picture named LaserEngraver.

22. Click on the Insert button.

23. Use the resizing handles to resize the picture if you need to.
24. Click in the first tear off on the left side.

25. Type TechZone@Main.

26. Press enter.

27. Type 330-643-9145.

28. Click in the second tear off area and your information should be duplicated.

Project 2: Calendar

1. Click on File.

2. Click on New.

3. For this exercise, click on the BUILT-IN headings

4. Select the Calendars category. >

5. Choose the Varsity
calendar.

6. On the right pane, you
will notice that you can
customize your sign by
changing to a different
color or a font scheme.

7. Click the drop-down
arrow next to color Calendars
scheme or font scheme

using the drop down arrows
8. You can change the Page Size to Landscape or Portrait.
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9.

10.
11.
12.
13.
14.

15.
16.

You can choose a Timeframe of One month per page or one year per page.

a. For class choose One month per page.

Choose Set Calendar Dates...button.
b. For class choose the current month.
Click on the Create button.
The current month calendar will open on your workspace.
You can type things into the square for the particular day.

a. For this class on every Wednesday, type Laser Engraver Workshop.
You can change the size of the columns and rows if you need to fit more information
on one day by clicking and dragging the dotted lines.

Right click on the image on the left.
Rest your mouse on the change picture.

17.When menu appears, choose Change Picture.

18
19
20
21
22

. Type in the Bing Image Search box something that corresponds to the month.
. Click on the picture you would like.

. Click on the insert button in the lower right corner.

. The picture you replaced will be on the right as a small version.

. Click in a blank area.

23.Right click on the original picture and choose delete.

Project 3: AWARD

arwnNpE

No

10

Click on File and New.
Select Built-In.
Select the category Awards. %
Select Star.
Make any changes you would like under color or
font
Click on the Create button.
Click in the Certificate of Appreciation box and
type: Certificate of Achievement
Click in the Name of Recipient box and type:
Your Name.
Click in the in recognition of valuable Award Certificates
contributions to and type: in recognition of
successful completion of laser engraver training.
. Click in the Business Name box and type: at the TechZone@Main.

11. Delete the top line/signature and line/date.

12. Resize all the text to size 24.

13. Change the name to Vivaldi and size 40.

14. Right Click on star, select change picture, choose change picture, in Bing Search

box search for a gold star.

15. Choose the gold star you like and click the insert button.
16. Delete the original picture following the steps learned before.

Copyright ©2007 ASCPL All Rights Reserved 3 of 12 9/11/2017 MMS/RV/DM



Certificate of
Achievement

This certificate is awarded to i
Qawn CMechan \

In recognition of successful
completion of laser engraver

at the TechZone@Main

Signature Date

Project 3: Create a Business Card

Step 1: Choose a design
1. Click on File and New.

Create New Business Information Se

2. Click on Built In. Business Information for this set

3. Choose Business Individual name: Tagline or motto:
Cards.Choose a Mie Mie Sann| Business Tagline or Motto
design you like. Job position or title: Logo:

4. Edit the color and font Technology Trainer

Organization name:

schemes to the right.
5. Click on Create new...

Akron-5ummit County Public Library

. Address:
under Business 60 5. High Street
information. Akron, Ohio 44326
6. Fill in the information in
the pop up box that Phone, fax, and e-mail:
Phone: 330-643-9145
ap_pears. Fax: 330-643-9146
7. Click Save. Email: msann@akronlibrary.org

Business Information set name: | Custom 1

Note: if the “Personal
Information” dialog box
does not appear
automatically because
information has previously been inputted, click Edit > Business Information. From
there you can Edit current information, Delete information, or create a New information
file. Make sure you name each Business Information set so that you can select different
sets for different business cards from a drop-down arrow.
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Business InfDrma‘tic:_

Select a Business Information set:

8. Use the drop-down arrow under “Select a Business
Information set” to select a different business
information set you previously created. See example
on right.

9. Whenever you see dotted underline of your text, the
text is imported from your already existing Business Information. You can

hover your mouse over the lines and the symbol "= will appear. If you click

the drop down arrow next to the , you have options to edit, save, update
your Business Information OR to convert the text to ‘plain text’ meaning you
can change those text lines to any new text without affecting your saved

8

Business Information. See sample below.
® |

Edit Business Infarmation. ..

Save to Buziness Information Set

Update from Buziness Information Set

LCarveert ta Plain Test

Step 2: Edit the information

10. Edit each line of text in the left column as appropriate. (Notice it imported your
information from the Business Information box.)

11.Depending upon the design template you chose, it may have an image or logo. To
change the image, use the steps outlined in the previous project.

Step 3: Printing your cards
12. Go to File > Print.

13. Select either one page (card) per sheet or

Print

multiple pages (cards) per sheet. [
14. Select how many cards to actually print on a O Copies of print job: | 1 -
sheet. =
Print
O 0000 0L 0 0
Akron-Summit County Public Likrary
Printer
[ia vwm Moshan i
' ) O ? ESCopier on staff-server] .
3014 Ready
Printer Properties
Settings
©:-0:-0-0:0:0-0- _
. o r Print All Pages
Akron-Summit County Public Likrary |_D A
Print the entire publication
T et = Pages: 1
LB}
13414 D Multiple copies per sheet -
Copies of each page: | 10 -
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Project 4. Create Labels

Click on the File menu and New.

Select Built-In, then Labels.

Choose All Mailing and Shipping.

Choose Offset (Avery 5160).

Select a color and font scheme from the area on

the right.

6. Click on the Create button.

7. Change the picture to a picture of a computer.

8. Click in the text box.

9. Go to the Mailings tab.

. Click Mail Merge button.

. Click Step by Step Mail Merge Wizard.

. Under create recipient list on the right hand side
of the screen, click Type a new list.

. Click Next: Create or connect to a recipient list
below.

. Enter three addresses in the pop up box that
appeared.

a. After entering the first person’s address,
press the new entry button.

arwnNpE

Mew Address List

Type recipient information in the table. To add more entries, click Mew Entry.

Ambassador (Avery
5160)

EERCI TUTION ULLAMCORFER @LMCT
EOMBESAIAT. Dafl TE FILMGFACT Bt

VLLAMISRFLR BUBC PN Sr e Nl
AT VERS DROS ET PEAN ET R8T
ENDE AD WO VENIAM, ST NO-ATRE

Customize

Color scheme:

lsland

[ v

Font scheme;

(default ternplate fonts) e

Business information:

|Li|::|rarj,r

CREATE

? X

T..w|Frst.. v|lss.. v | «|Addressine 1 «| |Cay

v |5 v |2IP Code | Country

Mr. i Srnith 555 Anywhere Akron

Mrs.  Minnie  Mouse 123 Mouse Lane COrlando FL

£

OH 44326

12343
44278

MNew Entry Find...

Delete Entry

15. Click OK when finished.
16. In the box by file name, type: classwork.
17. Click Save.
18. A new box will appear called
Mail Merge Recipients, click
OK. «
In task pane on right side of
screen, click all the _ .
categories you would like to TR
have added to the label. e
a. Title, First Name, Last =\ !
Name
b. Address
c. City, State, Zip Code
20. Click on the Preview Results Button.

Customize Columns...

19.
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21. Use the arrows on the ribbons to see the :
different addressed labels. Setti ngs

22. Now click on Next: Create merge r Print All Pages
publication at the bottom. D

. ) . . Print the entire publication
23. Go to File and Print or click Print on the

right hand side of screen. Pages 1
24. Under pages, choose multiple copies per
sheet bad P PIES P DD Multiple copies per sheet
25. Under copies of each label type in number =
of labels. Copies of each label: | 30 -

26. Under layout options, choose which row and
column to start with if you are using a
partially used sheet of labels.

Layout Options

Layout Options ? x
First Sheet: All Sheets:
Start row: |'I Side margin: 0188 Horizontal gap: |0.125

Ak ALK
Ak Ak

Start column: |1 Top margin: 0.5 Vertical gap: o

Close

Project 5: Newsletter

1. Click on the File menu and New.
2. Select Built-In, then Newsletters.
3. Select the Layers newsletter
4. You can make any changes to color or font scheme.
5. Under Page size choose One-page spread.
6. Click the Create button.
7. Right Click on Pages 2 and page 3 and choose delete.
8. Click on the Newsletter Title and type: TechZone@Main.
9. Inthe Newsletter Date text box, type: today’s date.
10. Under Special Points of Interest, type:
a. TechZone@Main offers Passport and Notary services.
b. We offer computer training.
c. We offer computer help on our public PCs.
d. Check with the staff about what maker machines are available.

Lead Story
1. Lead Story Headline box, type: Exciting News.
2. Right click on the body of the story, choose change text.
3. Choose text file.
4. Choose the Publisher folder.
5. Choose top front story.
6. Click OK.

7. Publisher will convert the text to fit in the given space.

8. Highlight the story and change the font size of the story to 11.

9. Right click on picture and choose ungroup.

10. Left click in a blank spot and then right click on picture.
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11.
12.
13.
14,
15.
16.

17.

Secondary Story Headline

1.
2.
3.
4.

5
6
7.
8.
9.
1

0.

Choose change picture.
Choose From a file. o
Choose the Publisher folder.
Choose the TechZoneMain2 photo.

Unselect the photo.

Click on the original photo and hit the delete key
on your keyboard.

Click in the text box under photo and type 3D
Printer available.

Click on the Secondary Story Headline
Type: Free Computer Classes. o J
Insert a bullet in the first text box underneath Free Computer Classes.

a. Classes offered monthly.
b. Limit of 15 per class.
c. Classes consist of basic to advanced.
d. Offered at Main and Branches.
e. Grab a calendar at any of our libraries.
Insert a picture of a computer.
Click on Insert.
Click on Online Pictures.
Type computer in the Bing Image Search box.
Choose a computer image and insert it.
Resize the picture and move it down near your bullet point.

Inside this issue

1.

2.

Type:
a. Special Points of Interest 1
b. Exciting News 1
c. Free Computer Classes 1
d. About TechZone@Main 2

e. Equipment Available 2
Delete the extra inside this issue information that you did not need to replace.

Business Tagline or Motto

NN E

Click on Business Tagline or Motto.

Type: About TechZone@Main

Right click on the body of the story, choose change text.
Choose text file.

Choose the Publisher folder.

Choose Business Tagline or Motto.

Click OK.

Publisher will convert the text to fit in the given space.

Insert Photo
The back of our newsletter seems a little boring. Let’s add a picture or two.

1.
2.
3.

Click on Insert.
Click on Online Pictures.
Search for Vinyl Printer.
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©

Back Page Story

PN

©o~No O

If time permits in class: Add Business Information to text boxes on the left. See Project 3.

Select a picture and insert it.

Click on Insert.

Click on Pictures.

Choose the Publisher folder.

Choose the TechZone-Logo-Black-Symbol
photo.

Resize bother photos as needed.

Click on the Back Page Story Headline.
Type: Equipment available.

Delete the photo.

Right click on the body of the story, choose
change text.

Choose text file.

Choose the Publisher folder.

Choose Back Page Story Head.

Click OK.

Publisher will convert the text to fit in the given space.

Add to We're on the Web!, www.akronlibrary.org

Project 6: Create Labels

1.
2.
3

o U

Click on the File and choose New.

Select Built-In, then Labels.

Under Mailing & Shipping, choose All Mailing &
Shipping, then choose Retro (Avery 5160).
(Notice the different types of labels available, like
Mailing, Return Address, CD/DVD, and Bookplate.)
Select a color and font scheme from the area on
the right.

Click on the Create button.

In order for Publisher to print the labels on the
specific paper you have purchased, you need to
tell the program what kind you have. Click on the
Page Design, then on Size and select a different
size from the many options.

@ Hd - =

FILE HOME IMSERT I PAGE DESIGNI
W B
B imi E

Change Options | Margins Orientatio
Template - -

Template Page Setup = <
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Customize
Color scheme:
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Business information:

Media Label
4.625 x 4.625"
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& Page Setup..
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Make any other formatting or color adjustments as desired. Note that you may have
to stretch the size of the design to fit a wider label.

For practice, follow the steps in the previous two projects to add Mail Merge

information into the Address box. Go the Mailings tab on the Ribbon.

9. Select the Mailing address section of text by clicking on it.

10.From the Ribbon, select the Mailings tab, then click on the words Mail
Merge, then click on Step-By-Step Mail Merge Wizard. The Maj

Wizard task pane will now appeaj on the right side of

8.

Ejl E - Publicationd - ME]I| I\/Ierge - X
FILE HOME INSERT PAGED MAILINGS ;
How Mail Merge works
Use Mail Merge to automatically add mailing addresses or
= personalized information to publications, Mail Merge is
ljl P made up of three parts.
Mail -rmail Select 1 Recipient list 2 Publication with merge
. fields
Merge = Merge = Recipients = First Name  Llast Name  Dear
Start W Tony Allen <+« First Name=> >
Adam Barr <<Llast Name>>
o |1 |z | ‘
D amac < I-|I|||I|||I||I|||I||I|||I| Judy !
3 Merged Dear Dear Dear
publications Tony Adam | Judy
Allen Barr Lew
Create recipient list
Select the data source you want to use to create your
recipient list, You can add more data to your list from other
sources later,
®) Use an existing list
Select a file or database with recipient information
Select from Outlook Contacts
Select names and addresses from an Outlook Contacts
folder
— Type a new list
. . Type the names and addresses of recipients
11.Click on Type a new list.=—
Steplof3

12.Then on Next: Create or con

: nect to =» Mext: Create or connedt to a recipient list
recipient list. e

o Help with Mail Merge
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13. Create a list of three individuals, by typing their first and last name, address, city,
state, and zip code in the New Address List dialog box. Use the <Tab> key to move

from one field to the next. Click <New Entry> to add another record.

Mail Merge Recipients ? X

This is the list of recipients that will be used in your merge. Use the options below to add to or change your list.

Use the checkboxes to add or remove recipients from the merge. When your list is ready, click OK.

Data Source |7 Last Name « | First Name - | Title | Company Mame w | Address

test.mdb |7 Meehan Dawn B0 5 Hil

test.mdb [¥  Mouse Minnie 1234 A

test.mdb ¥  MieMie Sann 5678 W
il Merge
are your publication
dd recipient information to your pu

i *| ) below to a location on the page,

Data sources: Add to recipient list Refine recipient list .

) T A
test.mdb {7 Select an existing list... 2} sort... Lt Mame
™! Select from Outlook Contacts... T Eilter... t Mame
EF Type a new list... I Find duplicates..  |mpany Name
[0 Eind recipient... dress Line 1
dress Line 2
= i
= te
Code
oK untry or Region

14. Click OK when finished and give your list a name.

15. Click OK in the Mail Merge Recipients window.

16. Be sure the Mailing Address section is selected again.
Then click on the item you wish to add to the field
(Address Block in this case).

17. When the Insert Address Block window opens,
select your options and click OK. The first person’s
name and address will appear in the text box.

Specify address elements Preview
[¥] Insert recipient's name in this format: Here is a preview from your recipient list:

Joshua 1 ]

Joshua Randall Jr. =

Joshua Q. Randall Jr. 3 i

Mr. Josh Randall Jr. Me Db Vicory
ASCPL

Mr. Josh Q. Randall Jr. 60 5. High Street

Mr. Joshua Randall Jr. Akron, Ohio 44326

Z Insert company name

[¥] Insert postal address:

Hﬁme Phone
Wark Phone
E-mail Address

Preview recipient:
L > A
[T} Find a recipient...
Exclude this recipient

C# Edit recipient list...

" i o Maore items
() Never include the country/region in the address

() Always include the country/region in the address

- Correct Problems
@ Only include the country/region if different than:

If items in your address block are missing or out of order, use
El Match Fields to identify the correct address elements from

United States
your mailing list.

[¥] Format address according to the destination country/region

B0 Picture field...
D Address block...
|:_°| Greeting line...

B0 Address fields...

Step 2 of 3

18. Click Next: Create Merged Publication, and
then choose the option to Print in the task pane
on the right.

=» Mext: Create merged publications

€ Previous: Create recipient list

@ Help with Mail Merge
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Appendix

Printing a Two-Sided Page (Duplex Printing)

Printing a page that is back to back is a process that is dependent upon the printer. Some
printers can perform duplex printing, which prints on both sides of the paper before ejecting
it, while other printers require the user to reload the paper manually. You should check
your printer manual to see if it supports double sided-printing.

Print a publication on a printer that supports duplex printing

Many printers support duplex printing, but they don't all make the duplex option available in
the same way. With some desktop printers, choosing duplex means that the printer prints all
of the copies of the first side of a page, then pauses and asks you to flip the sheets that it
just printed and return them to the printer, after which it prints all of the copies of the second
side. This method is called manual duplexing.

To print on both sides of a sheet of paper:

1. From the File menu, click Print.
2. Click Properties.

Note: The information in the Properties dialog box varies depending upon the
manufacturer of the printer you're using. With some printers, you will see a Layout tab
with a Print on both sides option on it. With other printers, you might see a Features tab,
and the duplex option might be called something like Two-sided printing. Explore the
various tabs in the Properties dialog box until you locate the duplex printing option.

3. Click OK to close the Properties dialog box, and then click OK again to close the
Print dialog box and print your publication.
Print a publication on a printer that does not support duplex printing

Even if your printer does not support duplex printing, you can still produce a double-sided
publication.

Display the side of the publication that you want to print first. In the Print dialog box, under

Print Range, click Current page. When the print run of the first side is complete, flip the
sheets over and reinsert them into the printer, and then print the other side.
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